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Background  
The PEPFAR data systems team has created S/GAC-Approved MER Analytic Favorites to be used by all DATIM users to 
asses MER data quality and perform data analysis. These favorites are in the form of pivot tables and visuals that have 
been designed to display MER results for each indicator and to guide program analysis. The purpose of this guide is to 
instruct DATIM users in how to use and customize DATIM pivot tables for data analysis. 
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About DATIM Pivot Tables 
What is a Pivot Table? 
A pivot table is a statistics tool that summarizes and reorganizes selected columns and rows of data in a spreadsheet or 
database table to obtain a desired report. Pivot tables help to summarize thousands of rows and columns of 
unorganized data into a report for data analysis. In DATIM, pivot tables can help to filter, access, and summarize large 
amounts of MER data which can be used for data quality checks or programmatic analysis. 

How DATIM Data Dimensions Can Be Used to Perform Programmatically Relevant Analysis 
DATIM Pivot Tables are made up of a series of data dimensions, which are bits of information that provide context to a 
data point, also called a data element. A data point is meaningless without the data dimensions that tell you the who, 
what, where, and when of the data. The S/GAC-Approved MER Analytics Favorites pre-select the correct data 
dimensions for each MER indicator, removing the guess work of creating your own pivot table from scratch. 

For example, given the data element of HTS_TST and the number two (2), it is impossible to know the meaning of that 
number two (2). We might be able to infer that two (2) people received HIV testing and counselling services, or from a 
larger pool of people receiving HIV testing and counseling services two (2) tested HIV-positive, but without more 
information we cannot begin to interpret HTS_TST and two (2) in a way that is programmatically significant. 

Depending on our analytic question, we need to know:  

• Who were these two people: What were their sexes? What were their ages?  
• What were their HIV test results: Were these two people tested HIV-negative or HIV-positive? 
• Where were they tested: Were they tested in a facility or community site? Within a facility, in what service did 

they receive HIV testing services? Were they tested in a geographic area with high HIV burden? 
• When were they tested: In which quarter of the past fiscal year were they tested? 

The who, what, where, and when of a data element allow for programmatically relevant analysis.  

Guide to MER Approved Analytics Favorites 
Types of MER Approved Analytics Favorites: MER Cleaning Favorites and MER Analytics Favorites 
S/GAC has created two types of MER Approved Analytics Favorites: MER Cleaning Favorites, which are in the form of 
pivot tables, and MER Analytics Favorites, which can take the form of pivot tables or visualizations. For the purpose of 
this training we will focus on pivot tables. 

Choosing which MER Approved Analytics Favorites to use depends on the analytical question you are trying to answer. 
First, decide if you need to use a MER Cleaning Favorite or a MER Analytics Favorite.  

• MER Cleaning Favorites: Use for programmatic analysis, such as an in-depth analysis of one indicator, or to view 
sum totals. These are approved analytics pivot table favorites related to the standard MER indicator categories 
(Prevention, Testing, Treatment, Viral Suppression, and Health Systems). Though these favorites’ primary 
function is to review MER data for data quality, they also can be very useful for programmatic analysis. Cleaning 
favorites mirror the MER data entry screen in DATIM.  

• MER Analytics Favorites (COP20 Analysis): Use this to analyze indicators that reflect the relationship between 
indicators, and calculated indicators such as HTS_TST Yield. These are approved analytics pivot table favorites 
intended to answer specific programmatic questions, such as those related to MER cascades, calculated 
indicators, Special Initiatives, and key populations.  

The MER Approved Analytics that you select will depend on the programmatic area that you are assessing or the 
programmatic question that you are answering. 
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Accessing MER Approved Analytics Favorites 
Accessing MER Cleaning Favorites 
Step 1: From the DATIM homepage or the DATIM Dashboard App, open the “MER Result & Target Review Favorites” 
dashboard. 

 

 

 

 

 

 

 

 

Step 2: Select the indicator and quarter for which you wish to view MER results. (This will depend on the program 
results that you want to view, and the programmatic question(s) that you want to answer. For guidance, see the section 
on “Example Scenarios.”)  

MER Approved Cleaning Favorites are organized by technical area (Prevention, Testing, Treatment, Viral Suppression, 
and Health Systems) and reporting period, from FY19 Q1 through FY20 Q4. MER targets are available for FY20 Q1. The 
MER Approved Analytics are also color-coded by indicator reporting frequency. For more information on MER indicator 
reporting frequency, refer to the MER Indicator Reference Guide on DATIM Support (datim.zendesk.com). 

MER Indicator Frequency 

Green = Quarterly 

Orange = Semi-annual 

Purple = Annual 

Accessing MER Analytics Favorites 
Step 1: From the DATIM homepage or the DATIM Dashboard App, open the “COP20 Analysis” dashboard. 

 

 

 

 

 

 

 

 

https://datim.zendesk.com/hc/en-us/articles/360000084446-MER-Indicator-Reference-Guides
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Data Dimensions of a DATIM Pivot Table 
The MER Approved Analytics Favorite will open for the selected indicator and time period. The pivot table will look like 
the below:  

 

 

 

 

 

 

 

Applied Data Dimensions 

The indicators that have been pre-selected for each MER Approved Analytics Favorite appear in the left menu of data 
dimensions under the “Data” data dimension. These calculated DATIM indicators have been pre-selected to correspond 
with the MER indicator you have chosen to analyze. 

 

 

 

 

 

 

 

Available Data Dimensions 

So, how do you choose data dimensions? Remember that to analyze data, the pivot table you create must include all 
data dimensions that are relevant to your analytic question. Every MER Approved Analytics Favorite is created to 
automatically populate with the minimum data dimensions required to analyze that indicator (if using a Cleaning 
Favorite) or relationship between indicators (if using an Analytics Favorite). However, you will likely want to adjust the 
search parameters to narrow down the data to view MER results for a specific OU, PSNU, Implementing Partner, or 
other data dimension. 

Below are screenshots of the available data dimensions, which are accessed from the gray data dimensions panel to the 
left of the pivot table. We have drawn blue boxes around the most commonly used data dimensions.  
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Inclusive and Specific Data Dimensions 

Many data dimensions offer options for “Inclusive” and “Specific” versions of the data dimension. Examples: Age and 
Sex (see “Frequently Used Data Dimensions”) 

• Inclusive: Use if there are a variety of disaggregates that can be summed together. 
• Specific: Use if you need to break out data by specific data sets (ex: age bands). 

Note: Inclusive and Specific data dimensions cannot be used together; however, multiple Inclusive or multiple Specific 
data dimensions can be used together. 

Frequently Used Data Dimensions 
Data Dimension: Organisation Units (OU) Description 
Organisation Unit (OU)  Filters MER results by organization unit. Organization unit will 

automatically be selected based on your DATIM permissions. If OU is not 
selected (i.e. if you are a Global DATIM user), use the gear icon to 
choose “Select levels” as the Selection Mode. Click “Update” to apply 
changes. 

 
 
 
 
 
 
 
 

Navigate through the dropdown menu to view MER results at the 
Country, Community, and Facility levels. Note: These are fictional OUs 
from a demo DATIM environment. 

Data Dimension: Age Description 
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Age Four age dimensions have been provided for use in breaking down your 
data by age. You will note two key words often uses in this set of 
dimensions, as well as elsewhere: 
• Specific: This relates to the specific age range entry box in the data 

entry form 
o <15 (specific) includes only <15 

 
• Inclusive: This relates to all age ranges that fit inside it 

o <15 (inclusive) includes <15, <1, 1-4, 5-9, 10-14 

 
Age: Cascade Age Bands (START HERE) The most commonly used age dimension is “Age: Cascade Age Bands” 

which follows the five-year bands implemented for COP18. This 
dimension includes each five-year band, as well as all other specific age 
ranges ever provided. 

Age: <15/15+ (Coarse) The second most commonly used age dimension is “Age: <15/15+ 
(Coarse)” which groups all age ranges into <15, >15, or Unknown. 

Data Dimension: HIV Testing Description 
HIV Test Status Filters MER results by HIV test results and HIV status. Within the HIV Test 

Status data dimensions, you will be given the option to select filters for 
“Specific” or “Inclusive.” 

HIV Test Status (Specific) This is the HIV testing dimension where you will most likely want to 
start, as it allows you to separate known positives from newly tested 
positives (e.g. PMTCT). It contains every specific option in an entry form 
that communicates an HIV status or test result.  

HIV Test Status (Inclusive) This dimension groups positives and negative results and statuses. It is 
useful for most HTS_TST modalities that do not record Known Positive or 
Recent Negatives. 

It filters by HIV test status: 
• HIV Positive (Inclusive): Includes “Newly Identified Positive”, “Known 

at Entry Positive”, and “HIV Positive”. 
• HIV Negative (Inclusive): Includes “Newly Identified Negative”, 

Recently Negative”, and “HIV Negative”. 
• HIV Status Unknown (Inclusive) 

Use this if you do not need to separate results by tested positive and 
known positive. 

HTS Modality Filter by testing modality. There is one data dimension each for release 
cycle and are grouped in the following ways:  

• FY18 Results/FY19 Targets 
• FY19 Results/FY20 Targets 
• FY20 Results/FY21 Targets 

Make sure to use the correct year dimension and note they should not 
be used for longitudinal analysis in a single pivot. 

Data Dimension: Sex Description 
Sex Filters MER results by sex. 
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Cascade Sex (START HERE) Filters by sex: Males, Females, and Unspecified Sex. If the data element 
does not use Male/Female, do not use cascade sex; sex is not 
automatically applied to indicators that do not ask for sex.  

• Ex: We do not ask for the sex of Key Populations; do not guess the 
sex of KP nor select unspecified. 

• Ex: We do not currently ask for the sex of Key Populations, nor do 
we apply Female to FSW or Male to MSM. 

Sex Do not use this data dimension. 
Data Dimension: Funding Mechanism Description 
Funding Mechanism Filters MER results by Implementing Mechanism (IM). Search by IM 

number to select a specific IM. If the selected OU is too large, IM results 
will not load. It is recommended to use this at the Country level or 
below. 

Data Dimension: Implementing Partner Description 
Implementing Partner Filters MER results by Implementing Partner (IP). Search by IP name to 

select a specific IP. If the selected OU is too large, IP results will not load. 
It is recommended to use this at the Country level or below. 

 

Applying Data Dimensions to a DATIM Pivot Table 
Analytic Example: Adolescent Girls and Young Women (AGYW) Who Completed the DREAMS Package 

To apply a data dimension to a pivot table, follow these steps: 

Step 1: Locate the Data Dimension 

Locate the data dimension you wish to select that applies to your analytic question. In this example, we are asking the 
analytic question, “How many Adolescent Girls and Young Women (AGYW) in each of our target age bands completed 
the full package of DREAMS services in our OU?” Therefore, our analytic question requires that we filter AGYW_PREV 
data by Age: Cascade Age Bands.  

The age ranges that are excluded from our filter (i.e. results will not appear in the pivot table) are shown in the left 
panel, under “Available” dimensions. Age ranges that are included in the filter (i.e. results will appear in the pivot table) 
are shown in the right panel, under “Selected” data dimensions.  

In this example, we are viewing the MER Approved Analytics for PEPFAR FY19Q4 Results AGYW_PREV. The age ranges 
of beneficiaries of the DREAMS program have been pre-selected in this favorite; they appear in the list of selected data 
dimensions at right.  

From the DATIM homepage or the DATIM Dashboard App, open the “MER Result & Target Review Favorites” 
dashboard for MER Cleaning Favorites. 
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Step 2: Selecting Data Dimensions 

Applying a data dimension (left): To apply a data dimension, select it from the list of available data dimensions. Then 
click the single arrow as shown. Clicking the double arrow will apply all available data dimensions to the pivot table. 

Removing a data dimension (right): To remove a data dimension, select it from the list of selected dimensions. Then 
click the single arrow as shown. Clicking the double arrow will remove all selected data dimensions from the pivot table. 

 

 

 

 

 

 

 

Step 3: Applying Changes 

After selecting data dimensions, click the “Update” button at the top left of the pivot table header to apply changes. You 
should see the numbers in the pivot table change. 

 

 

Changing the Layout of a DATIM Pivot Table to Facilitate Analysis of MER Results 
Changing the layout of a pivot table is often the first step in organizing data in a way that answers your analytic 
question. The table layout determines whether data appears in columns or rows, and which selected data dimensions 
appear in the table. The best way to learn the layout of the pivot tables is to spend some time testing the layout. To 
change the layout of a pivot table, follow these steps: 

Step 1: Open the “Layout” Menu of the Pivot Table 

To open the pivot table “Layout” menu, click the “Layout” button on the pivot table header. 

Applying a Data 
Dimension 

Removing a 
Data Dimension 
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Table Layout Options: 

Pivot Table Element Description 
Excluded dimensions Results for these are not displayed in the pivot table 
Report filter Results for these data dimensions are not displayed as rows or columns in the 

pivot table. To hide a data dimension, drag the data dimension here. Names of 
data dimensions listed here appear in the pivot table header.  

Column dimensions Data dimensions here appear as a column in the pivot table. 
Row dimensions Data dimensions here appear as a row in the pivot table. 

Step 2: Drag the data dimension(s) into the desired pivot table element to change the layout of the pivot table and the 
MER results that are shown. The example below illustrates how the pivot table layout changes when we move the data 
dimensions between the pivot table elements. Example: PEPFAR FY19Q4 Results AGYW_PREV. Note: We have 
combined the results of two (2) OUs to create false MER results. We will call this false OU the “Test OU.”  

Original: 

Pivot Table Element Data Dimensions 
Excluded dimensions Assigned categories 
Report filter Organisation units 

Periods  
Column dimensions Age: Cascade Age Bands 
Row dimensions Data  

 

 

 

 

 

 

 

 

With the Columns and Rows Swapped: 

Pivot Table Element Data Dimensions 
Excluded dimensions Assigned categories 
Report filter Organisation units 

Periods  
Column dimensions Data  
Row dimensions Age: Cascade Age Bands  
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Changing the Order of Data Dimensions 

To change the order of data dimensions in columns or rows of the pivot table, use drag and drop to change the order in 
which they are listed in the Table Layout.  

Hiding Empty Rows and Columns 

Notice that, depending on the table layout, the last row or column for the age band 25-29 (Specific) is empty, indicating 
that there are no MER results reported for this age band. To hide rows or columns without MER data, open the 
“Options” menu from the pivot table header. Select to “Hide empty columns” and “Hide empty rows.” Then click 
“Update” to apply changes. See screenshot below. 

Showing Column Totals and Row Totals 

To show column totals and row totals, open the “Options” menu from the pivot table header. Select to “Show column 
totals” and “Show row totals.” Then click “Update” to apply changes. Note: Depending on your analytic question and the 
way you organize your pivot table layout, you may not want to show column totals and row totals. Use the sum of 
columns and rows only when applicable to your analysis, as this may skew results when done incorrectly. If the column 
dimensions include multiple different indicators (Ex: Indicators from the Clinical Cascade), it is not analytically relevant 
to sum these numbers. See screenshot below. 

The image below shows the AGYW_PREV pivot table with the column and row totals applied, and with the empty 
columns and rows hidden. 
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The data in the orange box shows the answer to our original analytic question, “How many Adolescent Girls and Young 
Women (AGYW) in each of our target age bands completed the full package of DREAMS services in our OU?” 

Saving and Sharing a DATIM Pivot Table 
Customized MER Approved Analytics Favorites can be saved for future use. To save the pivot table, click “Favorites” > 
“Save As” and name the table. You will not be able to save changes to the original MER Approved Analytics Favorite. 

 

 

 

 

 

 

 

 

 

To open a saved pivot table, click “Favorites” > “Open.” This will show all pivot tables saved by DATIM users. Filter to 
“Created by me” to view your saved pivot tables. To share the link to the customized pivot table with others, copy and 
paste the URL. 

  

 

 

 

 

 

 

 

 

 

 

 

 

  

1 
2 

3 
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Example Scenarios 
Now we will walk through two (2) example scenarios of what the process for analyzing MER results using MER Approved 
Analytics Favorites might look like. The steps for selecting and using a MER Approved Analytics Favorite are as follows: 

1. Identify the program area of interest. 
2. Develop one to two questions about the program as a jumping off point. 
3. Based on the program area of interest and the questions you want to answer, identify the appropriate indicator 

to analyze. For guidance, refer to the MER Indicator Reference Guide on DATIM Support (datim.zendesk.com).  
4. Select the indicator and time period from the “MER Result & Target Review Favorites” dashboard on the DATIM 

homepage.  
5. Select the OU and apply additional data dimensions. 
6. Change the pivot table layout as needed. 
7. Adjust the pivot table options as desired. 
8. Analyze your data! 

Example Scenario #1: Clinical Cascade for Adolescent Girls and Young Women  
This is an example of a MER Analytics Favorite 

We will apply the above steps to the following scenario: 

1. In this example scenario, we are interested in analyzing the Clinical Cascade results for Adolescent Girls and 
Young Women, by Implementing Mechanism (IM).  

2. We want to answer the question, “For each Implementing Mechanism that provides HIV testing and treatment 
in my OU, what were the Clinical Cascade results for adolescent girls and young women?”  (Note: The Clinical 
Cascade includes: % of people who know their HIV status, % of people who know their HIV status who are on 
ART, and % of people on ART who are virally suppressed). 

3. How to determine which MER Approved Analytics Favorite to Use: Though there is a MER indicator that tracks 
adolescent girls and young women in PEPFAR-funded DREAMS Programs (AGWY_PREV), is this the right 
indicator to use to answer our question? We know that we want to look at results from the Clinical Cascade, 
which is not tracked in the AGWY_PREV indicator. However, results from the clinical cascade do include age/sex 
disaggregations. Therefore, we do not want to use the AGYW_PREV MER Cleaning Favorite. A better choice 
would be the MER Analytics Favorite for the Clinical Cascade, which we can then modify to focus on AGYW.  

4. Open the MER Approved Analytics Favorite for the Clinical Cascade in the COP20 Analytics dashboard, entitled 
the “PEPFAR FY20 Analytics: Clinical Cascade Overview.” Click the box and arrow icon next to the Analytic title 
to expand the pivot table. 

 

 

 

 

 
 

The pivot table will look like this when it opens:  
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The “Data” data dimension menu to the left of the pivot table shows the data dimensions that have been pre-selected 
for the “Clinical Cascade Overview” Analytic Favorite. These are all the indicators related to the Clinical Cascade: 

• (HTS_TST Total Numerator 
• HTS_TST_POS 
• HTS_TST Yield (%) 

 

 

 

 
 

 

5. Use the data dimensions panel at left to select the OU. For this example, we have combined the results of two 
(2) OUs to create false MER results. We will call this false OU the “Test OU.” Note: Depending on DATIM user 
permissions, some users will see their OU is automatically selected. 

 

 

 

 

 

 

 

 

 

• TX_NEW 
• Linkage to TX (%) 
• TX_CURR 

• Viral Load Tests Performed 
• Virally Suppressed 
• Viral Suppression (%) 
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Next, we need to filter results for Adolescent Girls and Young Women to filter results for females ages 10-24. 

Filter for ages 10-24:  Use the “Age: Cascade Age Bands” data dimension to select the age bands included in ages 10-24. 
Click “Update” to apply your selected data dimensions. The pivot table now shows results for each data dimension, 
broken out by age band. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Filter for Females: Use the “Cascade Sex” data dimension to filter for results for females only. Click “Update” to apply 
your selected data dimensions. The pivot table now shows results for females only. 
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6. Change the pivot table layout as needed: Depending on the programmatic question that we are trying to 
answer, there are certain results that we may want to focus on, and we can adjust the layout of the pivot table 
to help us focus our analysis. In this example, we recommend the following changes to the table layout: 

a. Sex: Since we are looking at Clinical Cascade results for AGYW and have applied the “Cascade Sex” data 
dimension, we already know that we are seeing results for females only and can hide the row for 
“Cascade Sex” to clean up the pivot table. 

b. Time Period: We may be interested in seeing results broken out by quarter, but we may prefer to see 
total results for the year.  

To make these changes, use the “Layout” menu to change the pivot table layout, as shown. Click “Update” to apply 
changes. 

Original:       New: 

 

 

 

 

 

 

 

 

 

 

Data dimensions that we moved into the “Report Filter” now appear in the pivot table header, instead of in the pivot 
table itself. To make the results easier to analyze, the Age: Cascade Age Bands are now in rows instead of columns. 

 

 

 

 

 

Now that we have changed the pivot table layout to make the results easier to analyze, we can narrow results down 
to specific Funding Mechanisms, also called Implementing Mechanisms (IM). 

Use the “Funding Mechanisms” data dimension to filter for the desired Funding Mechanisms. Click “Update” to apply 
your selected data dimensions. The pivot table now shows results for only the selected IMs. Note: We have masked the 
names of the IMs in the below screenshot and are not showing filtered data. 
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7. Adjust the pivot table options as desired. The Clinical Cascade MER Analytics Favorite does not show column 
totals by default, but you could use the Table Options to show column totals, as shown below:  

 

 

 

 

 

 

 

 

 

 

 

 

8. Analyze your data! 
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Example Scenario #2: Testing by Modality 
This is an example of a MER Analytics Favorite 

We will apply the above steps to the following scenario: 

1. In this example scenario, we are interested in analyzing the results for HIV Testing by Modality.  
2. We want to answer the question, “Which testing modality resulted in the highest yield (percentage of people 

who tested positive for HIV) for my OU, at the facility and community levels?”   
3. To answer this question, we want to look at the most recent results for HIV testing yield for all modalities (Index, 

Inpatient, Pediatric, etc.)  
4. Open the MER Approved Analytics Favorite for HIV Testing Modality in the “COP Analysis” dashboard. Click 

the box and arrow icon next to the Analytic title to expand the pivot table. 

 

 

 

 

 

 
The screenshot of the pivot table below shows what the table will look like when it opens. Note: Below the rows for 
Facility testing are rows for Community and Military testing (scroll down to view). 
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The “Data” data dimension menu to the left of the pivot table shows the data dimensions that have been pre-selected 
for the “HIV Testing by Modality” Analytics Favorite: 

• (HTS_TST Total Numerator 
• HTS_TST_POS 
• HTS_TST Yield (%) 

 

 

 

 

 

 

5. Use the data dimensions panel at left to select the OU. For this example, we have combined the results of two 
(2) OUs to create false MER results. We will call this false OU the “Test OU.” Note: Depending on DATIM user 
permissions, some users will see their OU is automatically selected. 

 

 

 

 

 

 

 

 

Next, filter results to show only the most recent results available. Use the “Periods” data dimension to filter for the 
most recent quarter for which data available, which is FY19 Q4. Click “Update” to apply changes. Note: This screenshot 
is from FY19 Q3. 
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Next, filter results to show only results for Facility and Community. Use the “Type of Organisational Unit” data 
dimension to filter for Facility and Community by moving “Military” from “Selected” to “Available”. Click “Update” to 
apply changes. 

 

 

 

 

The screenshot of the pivot table below shows what the table will look like when it opens. Note: Below the rows for 
Facility testing are rows for Community testing; Military testing has been removed (scroll down to view). 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. Change the pivot table layout as needed: Depending on the programmatic question that we are trying to 
answer, there are certain results that we may want to focus on, and we can adjust the layout of the pivot table 
to help us focus our analysis. In this example, we recommend the following changes to the table layout: 

a. Data/Period: Since we are interested in analyzing which testing modality had the highest yield in this 
OU, the emphasis should be on the testing modality, not on the type of organizational unit. For this 
reason, we recommend moving the Data to the rows. 

b. Time Period: We have already selected to show only the FY19 Q3 results, so there is no need to show 
this as a separate column. For this reason, we recommend moving Periods to the “Report Filter.” 

To make these changes, use the “Layout” menu to change the pivot table layout, as shown. Click “Update” to apply 
changes. 
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Original:       New: 

 

 

 

 

 

 

 

 

 

 

Data dimensions that we moved into the “Report Filter” now appear in the pivot table header, instead of in the pivot 
table itself. To make the results easier to analyze, the Data is now in rows instead of columns. 

 

 

 

 

 

 

 

 

 

 

 

 

7. Adjust the pivot table options as desired. The “Total” column has no data, marked with a series of dashes (-), 
because the data in this row is for multiple different indicators (HTS_TST Total Numerator, HTS_TST_POS, and 
HTS_TST Yield), so it cannot be summed. To clean up the pivot table, we recommend hiding empty rows and 
columns and unchecking the options to show column and row totals. 
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8. Analyze your data! 
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